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Over the past year, BSD has implemented
two different kinds of linking in the
CostLink/CM and AE cost estimating
products: Excel Linking and Parent Linking.
The initial linking release supported
dynamic data exchange between a cell in a
Microsoft Excel Workbook and a quantity
field in CostLink. Once linked, as the user
updates the Excel value, either directly or
through spreadsheet recalculation, the
CostLink value is updated to match. If the

Excel value is updated while the CostLink
project is closed, the CostLink quantity field
is updated the next time the project is
opened.

Excel workbooks can support quantity
takeoff for CostLink/CM and AE in a
number of ways. They can be used to list,
maintain, and audit the takeoff from a
digitizer or other takeoff device that outputs

The Summer 2003 BSD SoftLink CD-ROM
enables importing of a complete new section
into SpecLink or a new chapter into
PerSpective from word processing, com-
plete with preformatted notes and embedded
choices, if desired. Although users have
long been able to import text into an
existing SpecLink section or a PerSpective
chapter, the newest releases of both prod-
ucts provide a much more robust capability
that does not require the initial establish-
ment of a receiving document through the
use of a template. It’s also no longer
necessary to “clean up” the imported
document by deleting unnecessary text left
over from the template.

The new command that allows complete
document importation is Add New Section/
Chapter from RTF File, which can be found
on the Document/Section menu in SpecLink
and the Document/Chapter menu in
PerSpective. Before you can import the
section or chapter, you must first save it as
an RTF (Rich Text Format) document. In
Word, you accomplish this by choosing

Save As from the File menu, then selecting
the RTF option from the pull-down list of
file types. There are several rules that must
be followed to assure a clean import; those
described below are for SpecLink, but
similar rules apply to PerSpective.

First, be certain your cursor is on the correct
folder in the tree for the number of the
section you want to import. You will also
want to check that two settings on the Tools
menu are set appropriately: 1) If Auto-Select
New Paragraphs is turned on, all paragraphs
in the imported section will be selected
automatically; 2) There is a new menu
selection called Look for Choice Fields in
Import. If this option is turned on, the
import will automatically create embedded
choices within the imported document,
based on special paragraph formatting.

Next, verify that the first line of the docu-
ment says Section 00000, where the zeroes
are replaced by an appropriate 5-digit
number. The second line of the document
should be the title of the section. The three
parts of the section should each begin with
the word Part and must also include the
word General, Products, or Execution
(Part 1 General, Part 2 Products, and Part 3
Execution). The SpecLink software will
establish the hierarchy of other paragraphs

automatically, based on the amount of
indentation. The software will also strip out
of the text most paragraph numbering, since
SpecLink applies its own automated
paragraph numbering as text is selected.
Notes are designated by a line of at least ten
asterisks before and after the note and are
attached automatically to the paragraph
following the note.

Embedded choices of various types are
established by special formatting. For
example, [[apple] [orange] [banana]] will be
imported as an exclusive multiple choice
(one and only one may be chosen). Text
formatted ~~and <<apple>> <<orange>>
<<banana>>~~ will be imported as an
inclusive AND choice (one required). In this
instance, if all three are selected, the text
will read “apple, orange, and banana.”
Several other choice types are available,
including globally defined terms, fill-ins,
and units of measure.  Full details of choice
formatting can be found in the SpecLink+
Release Notes on your CD-ROM.

The notes and embedded choice capabilities
have also been added to the Import from
Clipboard feature on the Tools menu. These
improvements should make it much faster
and easier for you to build SpecLink or
PerSpective automated office master
projects by using text that was created
previously in word processing.

See “Linking Deserves a Look” on Page 2
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to Excel. Quantity fields can then be linked
directly to the takeoff from CM and AE.
Workbooks can also be used to build and
maintain the project’s Space Program,
values from which can be used to generate
floor, ceiling and wall areas linked to the
estimate.

Excel spreadsheets can also be used to
generate quantity models, projecting almost
any aspect of the project.  It is possible to
create a template project, pre-linked to
specific cells in a model spreadsheet. The
template project can then be used to start a
new project. The model spreadsheet can be
copied to create a new project-specific
version. Finally, links to the project can be
switched to the project-specific spreadsheet
with a single menu command, allowing
model quantity generation specific to the
new project.

The Spring 2003 release of CM and AE
delivered Parent Linking. With that release,
it became possible to set up a relationship
between the quantity on a task or folder and
the quantity of its parent folder. Using the
Item form, you can specify that the item
should draw its quantity from its parent
multiplied by a value (defaulting to 1).

This Summer release builds on the Parent
Linking and Excel Linking features by
extending them to allow copying links both

within a project and between projects. Links
are copied with the folder branch that
contains them. This makes it possible to set
up relationships within a set of folders
representing a building element or sub-
element and then to copy that element as
needed for new projects.

For example, it’s possible to use the roof
construction takeoff from one project to
build a “super assembly” based on roof
area. A super assembly is a folder containing
one or more line items and/or regular
assemblies constructed by the user or pulled
from a commercial price book such as the
RS Means Assemblies Database. Figure 1

below shows the Item form for the roof deck
line item out of a super assembly of roof
construction items.

Each item in the super assembly is linked to
the total area of roof on the parent folder
using a factor estimated or generated,
perhaps, from a previous takeoff. In the case
of the roof deck, 80% of the roof area will
be covered by the 22 gauge metal deck. To
use the assembly on a second project, copy
and paste the folder and all its contents and
change its quantity to the new total area of
the roof.

“Linking Deserves a Look” from page 1

See “Linking Deserves a Look” on page 5

As most construction business owners and
project managers fully know, estimating has
always been a critical component of the
construction process. Miscalculate the
estimate and you’re bound to see the ripple
effects of the inaccuracy later in the project.
Now, more than ever, as the recent down
economy has forced contractors to boost
their productivity in an increasingly
competitive marketplace, estimating has
taken on an even greater significance.

The sluggish economy has forced contrac-
tors to produce more estimates in a shorter
period of time using the same or fewer

resources. The result is usually that the
accuracy suffers, making estimates less
competitive, thereby diminishing the
chances of winning a job and being profit-
able on the projects in hand. At the same
time that all of this is happening, clients are
demanding more detailed estimates than
ever before.

To overcome this dilemma, more and more
contractors are turning to reliable estimating
software to help them produce accurate,
detailed and competitive estimates in a
timely fashion. One such contractor is
Bandza Construction, a commercial
contractor in New Lenox, IL. Bandza

Construction has been using Building
Systems Design’s CostLink/CM estimating
software for several years now, and accord-
ing to Joe Bandza, President and CEO, they
continue to not only win more and more
significant projects as a result of CostLink/
CM, but they are much more profitable due
to the accuracy in their estimates.

Joe tells us, “I give my customers the Direct
Cost Detail Report, a standard report within
CostLink/CM, which they love. They
repeatedly tell me that the flexibility in the
level of detail in my estimates gives them a
comfort level not typically found in other

See “CostLink/CM for Profit” on page 5

Bandza Uses CostLink/CM for Profit
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Figure 1 - A look at linking options in CostLink/AE’s task item form
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building standards is to build greater resistance to a terrorist attack into
all inhabited buildings.  That philosophy affects the general practice of
designing inhabited buildings.  While these standards are not based on
a known threat, they are intended to provide the easiest and most
economical methods to minimize injuries and fatalities in the event of
a terrorist attack.  The primary strategies to achieve this outcome are to
maximize standoff distance, to construct superstructures to avoid
progressive collapse, to reduce flying debris hazards, to provide
effective building layout, to limit airborne contamination, and to
provide mass notification.  The full document can be found at
www.tisp.org, the home of The Infrastructure Security Partnership,
which also contains many other security-related resources.

“Facilities Standards for the Public Buildings
Service (PBS-P100)”
This standard applies to all buildings constructed by the Public
Buildings Service (PBS) of GSA, which hires and manages private
sector professional architects, engineers, and contractors to design,
renovate, and construct federal buildings.  In particular, Chapter 8
covers basic security requirements.  The full document can be found at
http://hydra.gsa.gov/pbs/pc/facilitiesstandards.

SpecLink+ Statistics:

• 768 sections total, 199 updated or new
(26%)

• 1 new generic section
• 445 generic sections, 143 updated or new

(32%)
• 15 new proprietary sections
• 323 proprietary sections, 42 updated or new

(17%)
• 119,945 paragraphs
• 127,648 internal links (targets and

consequences)
• 19,651 notes to specifier
• 2,791 notes with live hyperlinks to Internet

web pages

13284 BSD - Removal and Disposal of U.S. Federal
Toxic Substances:
This new section covers removal and disposal of polychlorinated
biphenyls (PCBs) and other toxic substances regulated under the U.S.
Toxic Substances Control Act (TSCA). It is intended for use in projects
where PCBs, or materials containing PCB at concentrations of 50 parts
per million (ppm) and above, are to be removed and disposed of. The
section also includes incidental removal and disposal of mercury-
containing lamps, in the event that entire lighting fixtures with PCB

New Generic Section

Two new reference documents have been added to PerSpective to
enhance security design requirements.  Although both standards are
published by U.S. Government agencies, the requirements can be
applied to private sector construction as well.  Because security
requirements affect many different aspects of buildings, these two
documents are referenced under “Non-Regulatory Criteria Documents”
in Chapter 111 - Facility Requirements.

UFC 4-010-01, the Department of Defense’s
“Minimum Antiterrorism Standards for Buildings”
This standard applies to all new buildings constructed on DoD
installations, major retrofits of existing buildings on DoD installations,
and to leased commercial buildings that have a high concentration of
DoD employees.  In addition, these standards may be applicable to
commercial buildings where the private sector finds them acceptable.
This is a special public version of the non-sensitive infrastructure
security knowledge contained in DoD standards, which are the result of
years of research and development and actual design and construction
experience on military installations.  The philosophy behind these

• 2,044 external documents referenced, from
179 standards organizations

• 64 new documents (never before
referenced)

• 9 new standards organizations
• 1,989 manufacturer listings in generic

sections, 1,859 with live hyperlinks
• 1,008 unique manufacturers listed in 2,323

instances
• 848 unique manufacturers listed in 330

generic sections, 813 with live hyperlinks
• 233 unique manufacturers listed in 323

proprietary sections
• 806 manufacturers listed in generic sections

but not in proprietary
• 191 manufacturers listed in proprietary

sections but not in generic

containing ballasts are being  removed.
Federal EPA regulations regarding PCBs are contained in 40 CFR 761,
which can be accessed at www.access.gpo.gov/nara/cfr/cfrhtml_00/
Title_40/40cfr761_00.html. It is recommended that 40 CFR 761 be
read prior to specifying the removal of PCB waste. In addition to the
EPA regulations that apply to all states, states and local jurisdictions
may have more stringent regulations regarding this type of hazardous
waste.
The Contractor must use EPA-approved disposal sites and transporters.
The Owner is responsible for EPA-required record keeping, not the
Architect/Engineer.

Design for Security in PerSpective

About Your SpecLink & PerSpective Updates
PerSpective Statistics:
• 179 chapters, 22 updated (12%)
• 25,971 paragraphs
• 29,728 links
• 4,099 notes to specifier
• 607 external documents referenced
• 76 standards organizations referenced

The 2004 Edition of the Tile Council of
America’s Handbook for Ceramic Tile
is now available.  For your free copy,

email Schluter Systems -
kvaughn@schluter.com - with a note

that you are a BSD SpecLink
subscriber.
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02834 TET - Modular Concrete Retaining Walls
and 02836 TET - Mechanically Stabilized Earthen
Retaining Walls:
Tensar Earth Technologies, Inc.; Mesa(r) modular concrete and
SierraScape(r) stabilized earthen retaining walls with geogrids.
www.tensarcorp.com

04812 PCG - Glass Unit Masonry:
Pittsburgh Corning Corporation; hollow and solid glass blocks,
accessories, and mortar.  www.pittsburghcorning.com

05715 STW - Fabricated Spiral Stairs:
Stairways, Inc.; metal and wood spiral stairs; custom and standard; pre-
assembled and knocked down.  www.stairwaysinc.com

05810 IPC - Expansion Joint Cover Assemblies:
JointMaster, InPro Corporation; interior, exterior, seismic, and fire
barrier expansion joint covers.  www.inprocorp.com

07816 ADF - Intumescent Fireproofing:
A/D Fire Protection Systems; thin-film intumescent fire-resistive
coating for interior structural steel; optional decorative, low VOC top
coat.  www.adfire.com

07840 _3M - Firestopping:
3M Fire Protection Products, Inc.; firestopping for thru-penetrations
and construction gaps; intumescent, endothermic and ablative tech-
nologies.  www.3m.com/firestop

07840 ADF - Firestopping:
A/D Fire Protection Systems; firestopping and smoke seals; sealants,
mortars, intumescent caulk, pillows, collars, and firestop devices.
www.adfire.com

10155 GSP - Toilet Compartments:
Global Steel Products Corp.; steel, stainless steel, solid polymer plastic,
solid phenolic, and high pressure laminate faced toilet compartments.
Sections 10160 GSP - Metal Toilet Compartments, 10165 GSP - Plastic
Laminate Toilet Compartments, and 10171 GSP - Solid Plastic Toilet
Compartments have been withdrawn.  www.globalpartitions.com

10191 IPC - Cubicle Curtains:
InPro Corporation; cubicle curtain and I.V. track, curtains, and I.V.
holders.  www.inprocorp.com

10260 IPC - Wall and Corner Guards:
InPro Corporation; Flush mounted PVC corner guards; surface

• Effective February 1, 2003, the ICBO, SBC, and BOCA officially
combined to become the International Code Council, completing a process
of consolidation that began in 1994 and eliminating the three separate
model code organizations.
• The 2003 editions of the ICC International Codes have been added to
PerSpective, for both regulatory requirements and as optional owner
criteria documents (in Chapter 111).  Over the next quarter these new
editions will be evaluated for their effect, if any, on the product specifica-
tions in SpecLink.
• ICC Evaluation Service, Inc. (ICC-ES) has been launched, combining
the evaluation services operated by the three former code organizations.
This will have a beneficial
effect on product approvals,
making it less expensive to
obtain approvals acceptable in
all regions of the country.  Also,
because there will be only one
series of Research and Evalua-
tion Reports, architects and
engineers will find it much
easier to use and reference these
approval reports.  Under ICC-
ES rules, existing evaluation
reports have the status of
“Legacy Reports” and will
remain valid until changed.
Reports originally issued by one
of the individual services (e.g.
ICBO-ES) that are re-examined
with no changes, or with
editorial changes only, will be
processed as ICC-ES legacy
reports. Re-examinations that
involve technical changes, on
the other hand, will be
processed as new ICC-ES
reports.

International Code Changes

06414 ACC - Cabinet Drawer Slides and Cabinet
Accessories:
Accuride International; for drawer slides, keyboard trays, TV swivels,
and flipper doors for custom cabinets, manufactured casework, school
and store fixture casework, and office furniture. In conjunction with
this revision, Accuride has withdrawn  sections 12304 ACC - Drawer
Slides for Manufactured Casework, and 12504 ACC - Drawer Slides
and Accessories for Office Furniture.  www.accuride.com

New Proprietary Sections

mounted PVC, stainless steel, and clear polycarbonate corner guards.
www.inprocorp.com

10440 BSS - Interior Signage:
Best Sign Systems; architectural and ADA compliant interior signage.
www.bestsigns.com

10675 KDX - Movable Shelving System:
Kardex Information & Materials Management Systems; Kompakt(r)
electronic, mechanically operated, and manual movable shelving.
www.kardex.com

15415 GEB - Restroom Plumbing Fixtures:
Geberit Manufacturing, Inc.; pressure assist toilet, infrared sensor flush
valves and faucets, metering faucet.  www.us.geberit.com

15416 BRA - Restroom Lavatories:
Bradley Corporation; solid surface lavatory systems, single and group.
www.bradleycorp.com

Significantly Revised Proprietary Section

LinkLine
A BSD SoftLink® Publication
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Building Systems Design, Inc.
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Using linking to create relationships lets
you:

• Build in, use, and document “rules of
thumb” in your estimate;

• Approximate unknown quantities based
on known values;

• Change quantities quickly as the design
evolves;

• Reuse more work from one estimate to
the next.

Quantity linking supports a more detailed,
and therefore more accurate, estimate during
preliminary design and provides a baseline
for a more complete takeoff as design
progresses.

estimates.  It lets them know that when their
building is completed, they will not be
surprised with a lot of change orders for
items that otherwise would not have been
included in the estimate [bid]. CostLink/CM
gives me a distinct advantage by giving me
the flexibility to have my overhead and
profit either broken out separately or
included in the line item costs in a very
quick and simple manner.”

After recently completing upgrade training
at BSD’s Atlanta office, Joe is more
enthusiastic than ever. “When competing for
a job, and especially when several bids are
real close, CostLink/CM always gives me
the edge to win! The flexibility to produce

different levels of reporting detail provides
me with a significant competitive edge and
my customers with an unmatched reliability
that they appreciate and trust…and it shows
up on my bottom line. I just won another
project using CostLink/CM!” The proof is
in both the increased number of bids won
and the profitability that Bandza continues
to enjoy as his usage of CostLink/CM
increases. Bandza has completed over 50
projects to date using CostLink/CM and
profitability increases with each project. Joe
concludes, “Maybe I shouldn’t be telling
everyone this because my competitors might
see the light and purchase CostLink/CM and
cause me to lose some of my edge!”

“Linking Deserves a Look” from Page 2 “CostLink/CM for Profit” from Page 2

Organizations With Recently Verified Standards*
AA The Aluminum Association ............................................................................ 1
AABC Associated Air Balance Control ..................................................................... 1
AAMA American Architectural Manufacturers Association ..................................... 80
AASHTO American Association of State Highway & Transportation Officials ............ 58
AATCC American Association of Textile Chemists & Colorists .................................. 8
ABMA American Bearing Manufacturers Association ............................................... 2
ACGIH American Council of Governmental Industrial Hygienists ............................. 1
ACI American Concrete Institute International .................................................... 21
ADC Air Diffusion Council ..................................................................................... 1
AGC Associated General Contractors of America .................................................. 3
AI The Asphalt Institute ...................................................................................... 2
AIA American Institute of Architects ..................................................................... 1
AISC American Institute of Steel Construction ........................................................ 6
AISI American Iron and Steel Institute ................................................................... 2
AITC American Institute of Timber Construction .................................................. 12
AMCA Air Movement and Control Association International .................................. 11
ANSI American National Standards Institute ......................................................... 74
AOSA Association of Official Seed Analysts ............................................................ 1
APA APA - The Engineered Wood Association ...................................................... 3
API American Petroleum Institute ......................................................................... 7
ARI Air-Conditioning and Refrigeration Institute ................................................ 24
ASCE American Society of Civil Engineers ............................................................. 1
ASHRAE American Society of Heating, Refrigeration & Air-Conditioning Engineers 45
ASME The American Society of Mechanical Engineers .......................................... 56
ASSE American Society of Sanitary Engineering ..................................................... 9
ASTM American Society for Testing and Materials ................................................... 1
AWCI Association of Wall and Ceiling Industries International ................................ 1
AWI Architectural Woodwork Institute .................................................................. 1
AWPA American Wood Preservers’ Association ...................................................... 18
AWWA American Water Works Association ............................................................. 41
BHMA Builders Hardware Manufacturers Association ............................................ 26
BOMA Building Owners and Managers Association .................................................. 1
CAN National Standards of Canada ........................................................................ 2
CFR Code of Federal Regulations .......................................................................... 5
CGA Compressed Gas Association ......................................................................... 2
CISCA Ceiling and Interior Systems Construction Association .................................. 2
CISPI Cast Iron Soil Pipe Institute ........................................................................... 4
CLFMI Chain Link Fence Manufacturer’s Institute .................................................... 1
COE Corps of Engineers ......................................................................................... 4
CRA California Redwood Association .................................................................... 1
CRSI Concrete Reinforcing Steel Institute ............................................................... 3
CSA CSA International ........................................................................................... 9
CTI Cooling Technology Institute .......................................................................... 1
DASMA Door & Access Systems Manufacturers’ Association International ............... 1

DBIA Design Build Institute of America ................................................................ 15
DHI Door and Hardware Institute .......................................................................... 2
EPA Environmental Protection Agency .................................................................. 1
FAA Federal Aviation Administration ..................................................................... 5
FBC Florida Building Code .................................................................................... 3
FRSA Florida Roofing, Sheet Metal, and Air-Conditioning Contractors Association 1
GANA Glass Association of North America .............................................................. 2
HPVA Hardwood Plywood & Veneer Association .................................................... 1
HPW H.P. White Laboratory, Inc. ............................................................................ 1
ICBO International Conference of Building Officials ............................................... 1
ICC International Code Council .......................................................................... 11
ICPA Int’l Cast Polymer Alliance of the Composites Fabricators Association ........ 1
IEEE Institute of Electrical and Electronic Engineers ............................................ 33
IESNA Illuminating Engineering Society of North America ....................................... 5
IWCA International Window Cleaning Association ................................................... 1
MBMA Metal Building Manufacturers Association .................................................... 1
MPI Master Painters Institute ................................................................................. 2
NAAMM National Association of Architectural Metal Manufacturers ......................... 19
NACE NACE International ....................................................................................... 2
NAIMA North American Insulation Manufacturers Association .................................. 4
NCAA National Collegiate Athletic Association ........................................................ 1
NECA National Electrical Contractors Association ................................................... 8
NEMA National Electrical Manufacturers Association ............................................ 45
NETA InterNational Electrical Testing Association ................................................... 1
NFSMI National Food Service Management Institute ................................................. 1
NRCA National Roofing Contractors Association ..................................................... 2
NSF NSF International ........................................................................................... 5
PCI Precast/Prestressed Concrete Institute ............................................................ 2
NIST National Institute of Standards and Technology ............................................. 2
RTI Roof Tile Institute .......................................................................................... 1
SBCCI Southern Building Code Congress International ............................................ 1
SDI Steel Door Institute ...................................................................................... 18
SMACNA Sheet Metal & Air-Conditioning Contractors’ National Association ............ 12
SSPC Society for Protective Coatings .................................................................... 29
TAPPI TAPPI ............................................................................................................. 2
TCA Tile Council of America ................................................................................. 1
TIA/EIA Telecommunications Industry Association ..................................................... 1
TPI Truss Plate Institute ........................................................................................ 3
UL Underwriter Laboratories Inc. ...................................................................... 95
USGBC U.S. Green Buildings Council ........................................................................ 1
USPS United States Postal Service ........................................................................... 1
WDMA Window and Door Manufacturers Association ............................................... 1
WIC Woodwork Institute of California, now Woodwork Institute ......................... 1
WWPA Western Wood Products Association .............................................................. 2

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

* 914 documents were checked for validity in the last quarter.  When documents are revised, replaced, or withdrawn, the appropriate changes are made in every SpecLink section and PerSpective
chapter affected.  This is what we call “horizontal” updating, made possible by the fact that SpecLink and PerSpective use a relational database and both databases are reissued quarterly.
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All Products

Can we install a single user license
version on our file server?

Yes, you can use the Network Server
installation on your file server and

then you can install as many Client ma-
chines as you like. Your single user access
key will restrict the usage to one user at a
time.

I have performed the Install Master
Locally or Install System Files

Locally client installation, which is sup-
posed to increase the software speed, but the
software is not running any faster. Why isn’t
it faster?

Even though you installed the files
on your local drive, your software

may still be set to find the files on the server
instead of on the local drive. Open the
software but do not open any projects. From
the File menu choose Permissions, then
click the System Settings tab. For
SpecLink+ and PerSpective, the Master
Database Location should be set to the local
drive. For CostLink/CM and CostLink/AE,
the System Database Location should be set
to the local drive. To change this setting,
click the yellow folder to the right of the
line, choose the local drive from the drop-
down at the top, then navigate to and select
the file on the local drive. Click Apply. See
Setting the System Settings in the Installa-
tion document available on the Install BSD
Products screen of the latest BSD SoftLink
CD-ROM.

I just got a Windows XP computer
and I want to install BSD SoftLink

products. Do I have to be the Administrator
to install?

Yes, for Windows 2000, XP and NT,
you must have Administrator rights

to install.

My User Manual seems to be out of
date. For example, the screens in the

installation instructions do not look the
same as when I install the software. Can I
get updated instructions?

Yes. The User Manuals for each
product are periodically updated.

The updated copies are available on your
update CD-ROM in Word format, or they
can be downloaded from our website in
PDF format. To access the files on the CD,
start the Browser and go to the Info page for
the software you have. There is a button for
the User Manual on the right-hand side. To
access the files from our website, go to
www.bsdsoftlink.com, click the link for
Support on the left-hand side, and then click
the link for User Manuals.

What should I do when I get an error
message?

Contact BSD Technical Support. You
can email us at

support@bsdsoftlink.com or call toll free at
800-266-7732. For SpecLink+, PerSpective,
and CostLink/AE, free and unlimited
technical support is included with your
subscription. CostLink/CM users can
purchase our annual support plan, which
includes updates to the software and
unlimited technical support. When you call
about an error, it is best if you are at the
computer that is having the problem so we
can better troubleshoot and fix the problem.
If you prefer email, you can either type the
text of the relevant error message, or you
can copy and paste it from the
BSDERROR.LOG. You can attach the entire
log to your email if necessary.  The error log
is located in the User folder inside the local
directory where your BSD software is
installed - SpecLink+, CostLink CM,
CostLink AE or PerSpective. The most
recent errors are located at the end of the
log. Please also describe what you were
doing when the error occurred.

BSD CostLink/AE & CostLink/CM

I added a folder in the wrong place.
How can I move it?

To change the placement of a folder
in the Tree, with your right mouse

button drag the misplaced folder to the
folder that you want it to precede. When you
release the mouse button, choose Move
Above from the right mouse button menu.

In CostLink/CM, I am trying to copy
cost items from one estimate to

another, but the costs are not coming out the
same. Why?

There are a couple of reasons why
the Direct costs would not be exactly

the same when an item is copied from one
estimate to another. The most common
reason is that the resources (labor and
equipment rates) that are part of a line item
have already been defined within the new
estimate with different unit rates than in the
original estimate. Another reason could be
that each estimate has different direct cost
columns defined, so that not all of the unit
costs were copied from one estimate to the
other until the target project was modified to
include all of the direct cost columns in the
source project.

How can I create alternates in my
CostLink/CM estimate?

Reporting of alternates is available
with both portrait 1 and 2, and

landscape 1 reports. First be sure to set up
your estimate so that the entire Base Cost is
in your first level one folder and each level
one folder after that contains alternate costs.
When your estimate is complete, from the
File menu, choose Reports Setup. Select
Portrait 1 or 2 or Landscape 1, then select
the option Use Level One for Base Cost and
Alternates. Click OK. The folder icons for
the alternates now have plus signs on them.
When you print your reports, a total Base
Bid will be printed for the costs in your first
level one folder, and the following level one
folders will print as additive or deductive
alternates. If you need to modify the
estimate, it is best to unclick the Alternates
choice, modify the estimate, and then re-
select the choice.

In CostLink/CM, when I drag and
drop tasks from the CostBook into

my project, it takes too long. How can I
speed that up?
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subdocument to the document or folder that
you click on in the Tree panel prior to
pasting or creating the new section or
chapter. To fix it, you will need to move the
section or chapter. Click on the name of the
section or chapter in the Tree panel so that it
displays in the Document Panel. From the
Document menu, choose Sections (or
Chapters) and then choose Cut Section (or
Chapter). The Cut Section (or Chapter) for
Pasting dialog box opens asking you to
confirm that it is cutting the correct section
or chapter. Verify that it is and click OK.
Then click on the folder the section or
chapter belongs inside, and choose Docu-
ment, Sections (or Chapters), Paste Section
(or Chapter) Into. The Paste dialog box
opens giving you the opportunity to change
the number, acronym or name of the
document. Verify that the information is
correct and then click OK. The section or
chapter is moved to the proper location.

In SpecLink, are there any spec
sections that are specifically formu-

lated for Green Building / LEED require-
ments?

Section 01115 - Green Building
Requirements is a summary of what

the specs can do in aid of LEED certifica-
tion and where in the specs the requirements
appear. Also see sections 01575 - Tempo-
rary Erosion and Sedimentation Control,
01732 - Waste Management, and 01734 -
Indoor Air Quality. These are the primary
subjects covered by LEED credits that are
achievable by construction procedures
rather than by design. For more information
on LEED credits, go to www.usgbc.org to
get a copy of the LEED rating system
document.

There are several ways to make
building your estimate faster.

One way  is to be sure you do not have Auto
Recalculate Markups on. When this is on,
all of your markups are recalculated each
time you drop a task into your project. This
is turned on and off on the Tools menu.

A second way to speed up the process is to
have your Project and CostBook databases
on your local drive, rather than on a file
server. (If more than one person needs to
work in the estimate at the same time, this
alternative is not feasible.)

 A third way to speed up drag and drop is to
use a “referenced” database. This choice is
made on the General tab of the Summary
Info dialog box under Select Database
Methodology. Select the reference database
before you start adding costs to the estimate.
It is possible to use a referenced database
while building the estimate, and when the
estimate is complete, you can choose to
copy all the resources into your project.

BSD SpecLink+ & PerSpective

How can I tell what has changed in a
spec between when it was issued for

pricing and when it was issued for construc-
tion?

Use Compare Projects for tracking
changes between versions, and for

tracking changes in addenda. To use
Compare, be sure to keep a separate copy of
your project each time it is issued. For
example, when issued for pricing, keep a
copy of the file called [projectname] pricing
issue, and later for construction keep a
separate copy called [projectname] con-
struction issue. Also keep a copy for each
issuance of addenda.

When you are ready to see what is different
between two files, open the more recent
project file, and from the Tools menu
choose Compare. Select the older version of
the project file, and then select whether you
would like to generate a comparison of the
whole project, a branch, or a single section
or chapter. Then you will be able to print,
preview, or export a comparison to word
processing format.

In the comparison file, text that was added
to the more recent project will be under-
lined, and text that was deleted will be
struck out. There will also be a vertical line
to the right of paragraphs with changes to
help you and the reader more easily locate
them.

Do I have to select every paragraph
in order to print a section for

someone to mark up on paper?

No. In the Print dialog box, from the
Report to Print drop-down list,

choose either Draft Copy or Master Text
Copy, and under Report options, select to
print Project and/or Master Notes. Both
Master Text Copy and Draft Copy print all
paragraphs whether selected or not. Draft
Copy will also print any user-added para-
graphs.

Why are my projects so large when I
start them from my office master?

When you use your office master as
your project template for new

projects, you are essentially copying the
office master file. Therefore, each new
project will start out as large as the office
master and will get larger as you make edits
for this particular project. A better way to
start a new project that uses the data you
have accumulated in your office master is to
start a new project using the BSD template
(or your own empty, pre-formatted tem-
plate), and then import only the sections you
need into the new project. Not only will this
reduce the file size considerably, but it will
also improve speed when editing because of
the reduced size. You can copy multiple
sections or chapters from the office master
into your new project all at the same time
using the Import from Project Feature on the
Tools menu. For instructions on importing,
refer to chapter 6 of the updated copy of the
User Manual on the CD.

I have a section or chapter that looks
like a subsection or subchapter. How

did that happen and how do I fix it?

When you copy an existing chapter
or section, or create a new chapter or

section, the new document becomes a

More questions?
Contact BSD Technical Support:

Toll Free: 800-266-7732
In Atlanta: 404-365-9226

Email: support@bsdsoftlink.com
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BSD SpecLink+
1-1/2 days*  $495

June 16-17
July 7-8

August 4-5
September 8-9
October 20-21
December 8-9

AIA Members: Submit Course Completion
Certificate for 12 Continuing Education Units

CSI Members: Submit Course Completion
Certificate for 12 Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR

Certification renewal

* Class starts at 12:30 PM on Monday
afternoon and ends at 5 PM on Tuesday.

BSD CostLink/CM
3-1/2 days*  $1295

June 10-13
October 14-17
December 2-5

AIA Members: Submit Course Completion
Certificate for 24 Continuing Education Units

CSI Members: Submit Course Completion
Certificate for 24 Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR

Certification renewal

* Class starts at 8:30 AM on Tuesday morning
and ends at 11:30 AM on Friday.

View BSD class schedules on our website! Go to www.bsdsoftlink.com and click the Training link. Get directions and information on travel, hotels, and Atlanta!

BSD PerSpective
2 days*  $695

June 18-20
July 9-11

August 6-8
September 10-12

October 22-24
December 10-12

AIA Members: Submit Course Completion
Certificate for 16 Continuing Education Units

CSI Members: Submit Course Completion
Certificate for 16 Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR

Certification renewal

* Class starts at 12:30 PM on Wednesday
afternoon and ends at 12:30 PM on Friday.


